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1 Introduction 
1.1 About this Manual 

This manual provides information on how to set up EtherCAT Slave devices 
described with XML DDF files. These devices can be configured with the 
EtherCAT generic Slave DTM within an FDT Framework. 

1.1.1 Descriptions of the Dialog Panes 
The table below gives an overview for the individual dialog panes 
descriptions: 
 

Section Subsection Manual  
Page 

Configuration Overview Configuration 17 
 General  19 

 Behavior 20 

  State Machine Timeout 21 

  Device Check-up 22 

  Process Data 23 

  Watchdog 24 

 Distributed Clock 25 

 Process Data 30 

  Sync Manager 31 

  PDO Assignment (Index 0x1C10- 0x1C1F) 33 

  PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF) 35 

 Mailbox 36 
  CoE 36 
Description Overview Description 37 
 XML DDF Viewer 38 

Table 1: Overview Dialog Pages 

 

1.1.2 Online Help 
The generic EtherCAT Slave DTM contains an integrated online help 
facility. 

 To open the online help, click on Help or press F1. 
 
. 
 
 

1.1.3 List of Revisions 
Index Date Version Chapter Revision 
6 17-02-24 1.1000 1.4.1     Section Requirements Internet access added, Windows 

8.1 and Windwos 10 added. 
7 18-02-14 1.1000        Versioning information revised: Title page and this 

section 

Table 2: List of Revisions 
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1.1.4 Conventions in this Manual 

Notes, operation instructions and results of operation steps are marked as 
follows: 

Notes 
 
 

 

Important: <important note you must follow to avoid malfunction> 

 

 

Note:  <general note> 

 

 

<note, where to find further information> 

 

Operation Instructions 
 

1. <instruction> 

2. <instruction> 
 

or 
 

 <instruction> 

 

Results 
 

 <result> 
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1.2 Legal Notes 

Copyright 
© Hilscher Gesellschaft für Systemautomation mbH 

All rights reserved. 

The images, photographs and texts in the accompanying materials (in the 
form of a user's manual, operator's manual, Statement of Work document 
and all other document types, support texts, documentation, etc.) are 
protected by German and international copyright and by international trade 
and protective provisions. Without the prior written consent, you do not 
have permission to duplicate them either in full or in part using technical or 
mechanical methods (print, photocopy or any other method), to edit them 
using electronic systems or to transfer them. You are not permitted to make 
changes to copyright notices, markings, trademarks or ownership 
declarations. Illustrations are provided without taking the patent situation 
into account. Any company names and product designations provided in 
this document may be brands or trademarks by the corresponding owner 
and may be protected under trademark, brand or patent law. Any form of 
further use shall require the express consent from the relevant owner of the 
rights. 

Important notes 
Utmost care was/is given in the preparation of the documentation at hand 
consisting of a user's manual, operating manual and any other document 
type and accompanying texts. However, errors cannot be ruled out. 
Therefore, we cannot assume any guarantee or legal responsibility for 
erroneous information or liability of any kind. You are hereby made aware 
that descriptions found in the user's manual, the accompanying texts and 
the documentation neither represent a guarantee nor any indication on 
proper use as stipulated in the agreement or a promised attribute. It cannot 
be ruled out that the user's manual, the accompanying texts and the 
documentation do not completely match the described attributes, standards 
or any other data for the delivered product. A warranty or guarantee with 
respect to the correctness or accuracy of the information is not assumed. 

We reserve the right to modify our products and the specifications for such 
as well as the corresponding documentation in the form of a user's manual, 
operating manual and/or any other document types and accompanying 
texts at any time and without notice without being required to notify of said 
modification. Changes shall be taken into account in future manuals and do 
not represent an obligation of any kind, in particular there shall be no right 
to have delivered documents revised. The manual delivered with the 
product shall apply. 

Under no circumstances shall Hilscher Gesellschaft für Systemautomation 
mbH be liable for direct, indirect, ancillary or subsequent damage, or for 
any loss of income, which may arise after use of the information contained 
herein. 

Liability disclaimer 
The hardware and/or software was created and tested by Hilscher 
Gesellschaft für Systemautomation mbH with utmost care and is made 
available as is. No warranty can be assumed for the performance or 
flawlessness of the hardware and/or software under all application 
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conditions and scenarios and the work results achieved by the user when 
using the hardware and/or software. Liability for any damage that may have 
occurred as a result of using the hardware and/or software or the 
corresponding documents shall be limited to an event involving willful intent 
or a grossly negligent violation of a fundamental contractual obligation. 
However, the right to assert damages due to a violation of a fundamental 
contractual obligation shall be limited to contract-typical foreseeable 
damage. 

It is hereby expressly agreed upon in particular that any use or utilization of 
the hardware and/or software in connection with 

• Flight control systems in aviation and aerospace; 

• Nuclear fusion processes in nuclear power plants; 

• Medical devices used for life support and 

• Vehicle control systems used in passenger transport 

shall be excluded. Use of the hardware and/or software in any of the 
following areas is strictly prohibited: 

• For military purposes or in weaponry; 

• For designing, engineering, maintaining or operating nuclear systems; 

• In flight safety systems, aviation and flight telecommunications systems; 

• In life-support systems; 

• In systems in which any malfunction in the hardware and/or software 
may result in physical injuries or fatalities. 

You are hereby made aware that the hardware and/or software was not 
created for use in hazardous environments, which require fail-safe control 
mechanisms. Use of the hardware and/or software in this kind of 
environment shall be at your own risk; any liability for damage or loss due 
to impermissible use shall be excluded. 

Warranty 
Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that 
the software shall run without errors in accordance with the requirements 
listed in the specifications and that there were no defects on the date of 
acceptance. The warranty period shall be 12 months commencing as of the 
date of acceptance or purchase (with express declaration or implied, by 
customer's conclusive behavior, e.g. putting into operation permanently). 

The warranty obligation for equipment (hardware) we produce is 36 
months, calculated as of the date of delivery ex works. The aforementioned 
provisions shall not apply if longer warranty periods are mandatory by law 
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a 
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all 
due care taken, the delivered product should have a defect, which already 
existed at the time of the transfer of risk, it shall be at our discretion to 
either repair the product or to deliver a replacement product, subject to 
timely notification of defect. 

The warranty obligation shall not apply if the notification of defect is not 
asserted promptly, if the purchaser or third party has tampered with the 
products, if the defect is the result of natural wear, was caused by 
unfavorable operating conditions or is due to violations against our 
operating regulations or against rules of good electrical engineering 
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practice, or if our request to return the defective object is not promptly 
complied with. 

Costs of support, maintenance, customization and product care 
Please be advised that any subsequent improvement shall only be free of 
charge if a defect is found. Any form of technical support, maintenance and 
customization is not a warranty service, but instead shall be charged extra. 

Additional guarantees 
Although the hardware and software was developed and tested in-depth 
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall 
not assume any guarantee for the suitability thereof for any purpose that 
was not confirmed in writing. No guarantee can be granted whereby the 
hardware and software satisfies your requirements, or the use of the 
hardware and/or software is uninterruptable or the hardware and/or 
software is fault-free. 

It cannot be guaranteed that patents and/or ownership privileges have not 
been infringed upon or violated or that the products are free from third-party 
influence. No additional guarantees or promises shall be made as to 
whether the product is market current, free from deficiency in title, or can be 
integrated or is usable for specific purposes, unless such guarantees or 
promises are required under existing law and cannot be restricted. 

Confidentiality 
The customer hereby expressly acknowledges that this document contains 
trade secrets, information protected by copyright and other patent and 
ownership privileges as well as any related rights of Hilscher Gesellschaft 
für Systemautomation mbH. The customer agrees to treat as confidential all 
of the information made available to customer by Hilscher Gesellschaft für 
Systemautomation mbH and rights, which were disclosed by Hilscher 
Gesellschaft für Systemautomation mbH and that were made accessible as 
well as the terms and conditions of this agreement itself. 

The parties hereby agree to one another that the information that each 
party receives from the other party respectively is and shall remain the 
intellectual property of said other party, unless provided for otherwise in a 
contractual agreement. 

The customer must not allow any third party to become knowledgeable of 
this expertise and shall only provide knowledge thereof to authorized users 
as appropriate and necessary. Companies associated with the customer 
shall not be deemed third parties. The customer must obligate authorized 
users to confidentiality. The customer should only use the confidential 
information in connection with the performances specified in this 
agreement. 

The customer must not use this confidential information to his own 
advantage or for his own purposes or rather to the advantage or for the 
purpose of a third party, nor must it be used for commercial purposes and 
this confidential information must only be used to the extent provided for in 
this agreement or otherwise to the extent as expressly authorized by the 
disclosing party in written form. The customer has the right, subject to the 
obligation to confidentiality, to disclose the terms and conditions of this 
agreement directly to his legal and financial consultants as would be 
required for the customer's normal business operation. 
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Export provisions 
The delivered product (including technical data) is subject to the legal 
export and/or import laws as well as any associated regulations of various 
countries, especially such laws applicable in Germany and in the United 
States. The products / hardware / software must not be exported into such 
countries for which export is prohibited under US American export control 
laws and its supplementary provisions. You hereby agree to strictly follow 
the regulations and to yourself be responsible for observing them. You are 
hereby made aware that you may be required to obtain governmental 
approval to export, reexport or import the product. 
 

 

1.3 Registered Trademarks 
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1 
and Windows® 10 are registered trademarks of Microsoft Corporation. 

EtherCAT® is a registered trademark of Beckhoff Automation GmbH, Verl, 
Germany, formerly Elektro Beckhoff GmbH. 

All other mentioned trademarks are property of their respective legal 
owners. 

 

1.4 About EtherCAT Generic Slave DTM 
You can use the EtherCAT generic Slave DTM to configure the EtherCAT 
Slave devices described with XML DDF files within a FDT Framework.  

The information necessary for the configuration of the EtherCAT Slave 
devices is stored within the EtherCAT Master device when using the 
EtherCAT generic Slave DTM and thus the Master device is configured. 
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1.4.1 Requirements 
System Requirements 

• PC with 1 GHz processor or higher 

• Windows® XP SP3,  
Windows® Vista (32-Bit) SP2,   
Windows® 7 (32-Bit and 64-Bit) SP1,   
Windows® 8 (32-Bit and 64-Bit),  
Windows® 8.1 (32-Bit and 64-Bit),   
Windows® 10 (32-Bit and 64-Bit) 

• Administrator privilege required for installation 

• Internet Explorer 5.5 or higher 

• RAM: min. 512 MByte, recommended 1024 MByte 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 

• Restriction: Touch screen is not supported. 
 

 

Note: If the project file is used on a further PC,  

 this PC must also comply with the above system requirements, 

 the device description files of the devices used in the project must be 
imported into the configuration software SYCON.net on the new PC, 

 and the DTMs of the devices used in the project must also be installed 
on that further PC. 

 
 

Requirements EtherCAT Generic Slave DTM 

Requirements for working with the EtherCAT generic Slave DTM are: 

• Installed FDT/DTM V 1.2 compliant frame application 

• Installed EtherCAT Master DTM 

• DDF file of the devices to be configured 

• The user needs to reload the Device Catalog 
 

Loading XML DDF files 
To add devices to the netDevice device catalog, you must import the XML 
DDF file of the used device via netDevice menu Network > Import Device 
Descriptions …. into the DDF folder of the DTM. Then the Device 
Cataloge must be reloaded. The folder DDF inclusively Windows® XP is 
located in the application data directory (All Users) of the configuration 
software (or from with Windows® 7 on in the C:\ProgramData\ SYCONnet 
directory). 
 

 

For further information refer to section Configuration Steps on page 16 , 
under step 1 and 2. 
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1.5 Dialog Structure of the EtherCAT Generic Slave DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
DTM. 

 

 
Figure 1: Dialog Structure of the Generic EtherCAT Slave DTM 

 

 



Introduction 12/43 

Generic Slave DTM for EtherCAT Slave Devices | Configuration of EtherCAT Slave Devices  
DOC071202OI06EN | Revision 6 | English | 2018-03 | Released | Public  © Hilscher, 2007-2017 

1.5.1 General Device Information 
 

Parameter Meaning 
IO Device Name of the device 

Vendor Vendor name of the device 

Device ID Identification number of the device 

Vendor ID Identification number of the vendor 

Table 3: General Device Information 

 
 

1.5.2 Navigation Area 
The Navigation Area contains folders and subfolders to open the dialog 
panes of the DTM. 

 
Figure 2: Navigation Area 

 

 Select the required folder and subfolder. 

 The corresponding Dialog pane is displayed.  

Hide / display Navigation 
 

 Hiding the navigation area (above right side). 

 
Opening the navigation area (below left side). 
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1.5.3 Dialog Pages 
At the dialog pane the Configuration or Description panes are opened via 
the corresponding folder in the navigation area. 
 

Configuration 
General At the General pane EtherCAT Slave information is displayed. For further information, refer 

to section General on page 19. 

Behavior At pane Behavior the parameters of the Device checkup, the Process Data and the 
Watchdog are described. For further information, refer to section Behavior on page 20. 

Distributed Clock At the pane Distributed Clock, the DC Sync mechanism and Sync0 and Sync1 can be 
activated and the parameters Sync 0 Cycle Time, Sync 0 Shift Time, Sync 1 Cycle Time and 
Sync1 Shift Time can be determined and set. For further information, refer to section 
Distributed Clock on page 25. 

Process data At pane Process Data the parameters of the Sync Manager are displayed, the PDO 
Assignment and the PDO content. For further information, refer to section Process Data on 
page 30. 

Mailbox At pane Mailbox you can get information on mailbox-based data transfer and the CoE 
(CANopen over Ethernet) functionality. For further information, refer to section Mailbox on 
page 33. 

Description 
XML DDF Viewer By use of the XML DDF-Viewer a DDF file can be viewed and searched through. For further 

information, refer to section XML DDF Viewer on page 38. 

Table 4: Overview Dialog Panes 
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1.5.4 OK, Cancel, Apply and Help 
OK, Cancel, Apply and Help you can use as described hereafter. 
 

 Meaning 
OK To confirm your latest settings, click OK. All changed values will be applied on the frame application 

database.  
The dialog then closes. 

Cancel To cancel your latest changes, click Cancel.  
Answer to the safety query Configuration data has been changed. Do you want to save the data? 
by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on the frame application 
database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application 
database.  
The dialog remains opened. 

Help To open the DTM online help, click Help.  

Table 5: OK, Cancel, Apply and Help 

 

1.5.5 Table Lines 
In the DTM dialog pane table lines can be selected, inserted or deleted. 
 

 Meaning 

 
To select the first line of a table use First Line. 

 
To select the previous line of a table use Previous Line. 

 
To select the next line of a table use Next Line. 

 
To select the last line of a table use Last Line. 

 
Create a new Line inserts new lines into the table. 

 
Delete selected Line deletes the selected line from the table.  

Table 6: Selecting, inserting, deleting Table Line 
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1.5.6 Status Bar 
The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. the DTM connection state, is signaled graphically 
via icons in the status bar. 
 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

Table 7: Status Bar Icons [1] 

 

Offline State 
 

 

Online State 
 

 

Figure 4: Status Bar Display Example 
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2 Getting started 
 

2.1 Configuration Steps 
The following table describes the steps to configure a EtherCAT Slave 
device with the EtherCAT generic Slave DTM as it is typical for many 
cases. At this time it is presupposed that the EtherCAT Master DTM 
installation was already done. 
 

# Step Short Description For detailed information see 
section 

Page 

1 Add EtherCAT Slave in 
the Device Catalog 

Add the Slave in the Device Catalog by 
importing the device description file to 
the Device Catalog. 
Depending of the FDT Container. 
For netDevice: 
- Network > Import Device 
Descriptions. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Load device catalog Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select button Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

3 Create new project / 
Open existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See Operating Instruction 
Manual of the Frame 
Application) 

- 

4 Insert Master or Slave 
into configuration 

Depending of the FDT Container: 
For netDevice: 
- in the Device Catalog click to the 
Master, 
- and insert the device via drag and drop  
to the line in the network view, 
- in the Device Catalog click to the Slave, 
- and insert the device via drag and drop  
to the Master bus line in the network 
view. 

- - 

5 Configure Slave Configure the Slave. 
- Double click to the device icon of the 
Slave. 
- The generic Slave DTM configuration 
dialog is displayed. 
In the generic Slave DTM configuration 
dialog: 
-  configure the EtherCAT device 
parameters. 
- close the generic Slave DTM 
configuration dialog via the button OK. 

Configuring Device 
Parameters 
 
 
 
 

18 
 
 
 
 

6 Configuration Steps 
Master device 

Configure the Master device via 
EtherCAT-Master DTM. 

(See Operating Instruction 
Manual DTM for EtherCAT-
Master devices) 

- 

7 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

 
(See Operating Instruction 
Manual of the Frame 
Application) 

- 

Table 8: Getting started - Configuration Steps 
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3 Configuration 
3.1 Overview Configuration 

Dialog Panes “Configuration” 
The table below gives an overview about the available Configuration 
dialog panes descriptions: 
 

Section Manual  
Page 

Overview Configuration 17 
General  19 

Behavior 20 

 State Machine Timeout 21 

 Device Check-up 22 

 Process Data 23 

 Watchdog 24 

Distributed Clock 25 

Process Data 30 

 Sync Manager 31 

 PDO Assignment (Index 0x1C10- 0x1C1F) 33 

 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF) 35 

Mailbox 36 
 CoE 36 
Overview Description 37 
XML DDF Viewer 38 

Table 9: Descriptions of the Dialog Pages Configuration 

 

 
Figure 5: Navigation Area - Configuration 

 

 

For information to further steps as Download Configuration or 
Diagnosis, refer to the Operating Instruction Manual DTM for EtherCAT 
Master devices. 
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3.2 Configuring Device Parameters 
The following steps are needed to configure the device parameters using 
the EtherCAT generic Slave DTM: 

 Configure the behavior of the EtherCAT-Slave as described in section 
“Behavior” at page 20. 

 On the Behavior page set the parameters for  

• the Device checkup,  

• the Process data  

• and the Watchdog. 

 Configure the process data of the EtherCAT-Slave as described in 
section Distributed Clock at page 25. 

 On the Process Data page set the parameters for  

• the Sync Manager,  

• the PDO Assignment (0x1C10-0x1C2F) 

• and the PDO Content (0x1600-0x17FF). 
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3.3 General 
The General dialog page shows the Description of the EtherCAT Slave. 
 

 
Note: The Station Address is set by the EtherCAT Master, therefore the 
corresponding data field is not editable. 

 

 
Figure 6: Configuration > General 

 

Parameter Meaning 
Description Symbolic Name of the EtherCAT Slave station. 
Device type Device type as defined in the DDF 
Device name Device name as defined in the DDF 
Product revision Product revision as defined in the DDF or E²PROM 
Physics EtherCAT Port configuration: available ports and their types. 
Station Address Station Address denominates a logical address.  

The station address of a slave is set in the master DTM. 

Table 10: General Page Parameters 

 

Physics in the context of EtherCAT Port configuration is described by two 
characters indicating the physical interface of the connection. The coding is 
as follows: 
 

Physics Port type 
K E-Bus 
Y 100Base-TX 
F 100Base-FX  

Table 11: Coding of Parameter "Physics" 
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3.4 Behavior 
At the page Behavior, the parameters of  

• the state machine timeout values 

• the device checkup,  

• the process data  

• and the watchdog timer. 

are set and displayed. 

 

 
Figure 7: Configuration > Behavior 
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3.4.1 State Machine Timeout 
For various transitions between states of the EtherCAT slave state machine 
the associated timeout values can be configured separately in the state 
machine timeout section of the ‘Behavior’ dialog: 

• I2P 
This value applies to the transition from Init state to Pre-Operational 
state 

• P2S, S2O   
This value applies to the transition from Pre-Operational state to Safe-
Operational state and from Safe-Operational state to Operational state. 

• Back to P, I   
This value applies to the transition from any higher state back to Pre-
Operational state or Init state. 

• O2S  
This value applies to the transition from Operational state to Safe-
Operational state. 

 

 
Note: These timeout values are specified in units of milliseconds. 

 

 
Figure 8: Configuration > Behavior > State Machine Timeout - Configuration 
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3.4.2 Device Check-up 
The device check-up part of the Behavior dialog looks like: 

 
Figure 9: Configuration > Behavior > Device Check 

The following table shows which items identifying the EtherCAT device can 
optionally be verified during device check-up if marked in the dialog 
accordingly. 
 

Parameter Meaning 
VendorID Device’s vendor ID (DDF or stored device-internally) 
Product code Device’s product code (DDF or stored device-internally) 
Revision Device’s revision (DDF or stored device-internally) 

Table 12: Parameters Behavior > Device checkup 

 

The values within the DDF file are verified against the corresponding 
information stored in the device (for example, within an E²PROM circuit), if 
the according check box is marked.  
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3.4.3 Process Data 
EtherCAT supplies different command sets for reading and writing: 

• a combined read/write command (LRW) 

• separate read and write commands (LRD/LWR) 

This option allows to choose between these alternatives: 
 

 
Figure 10: Configuration > Behavior > Process data 

 

Parameter Meaning 
Use LRD/LWR 
instead of LRW 

Logical read and write operation: 
If marked, separate EtherCAT read (LRD) and write 
(LWR) commands will be used. 
Otherwise, a combined EtherCAT read and write 
(LRW) command will be used. 

Table 13: Parameters Behavior > Process data 

 

For more information on EtherCAT read and write commands see the 
EtherCAT Communication Specification, version 1.0, section 6.2 “EtherCAT 
Services”, page 43. 
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3.4.4 Watchdog 
Both the entire PDI (Process Data Interface) and all sync managers 
(separately) are monitored by watchdog timers.  

The following rules apply for resetting the watchdog timers: 

• Each access from the application controller to the EtherCAT Slave 
controller resets the watchdog timer of the Process Data Interface. 

• Each write access to the associated memory area of a sync manager 
resets the sync manager’s watchdog timer. 

The watchdog timeout values can be calculated using the formula given 
below from an individually configurable value and a common multiplier.  

The “Watchdog” part of the “Behavior” dialog allows specifying the 
multiplier and the individual values for PDI watchdog and sync manager 
watchdogs. 

 
Figure 11: Configuration > Behavior > Watchdog 

 

Parameter Meaning 

Set multiplier Watchdog multiplier, content of the register 0x400 
Set PDI watchdog PDI watchdog, see note below 
Set SM watchdog SM watchdog, see note below 

Table 14: Parameters Behavior > Watchdog 

 

 
Note: The PDI & SM watchdog timeout values are calculated as follows. 

PDI watchdog timeout =  

([value of register 0x400] + 2) * 40 * [value of register 0x 410] 

SM watchdog timeout =  

([value of register 0x 400] + 2) * 40 * [value of register 0x 420] 
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3.5 Distributed Clock 
At the page Distributed Clock, the DC Sync mechanism and Sync0 and 
Sync1 can be activated and the parameters  

• Sync 0 Cycle Time,  

• Sync 0 Shift Time,  

• Sync 1 Cycle Time  

• and Sync1 Shift Time  

can be determined and set: 

 
Figure 12: Configuration > Distributed Clock 

Operation Mode 
There are three operation modes available for Distributed Clocks. These 
are:  

• DC unused 

• DC for synchronization 

• User-defined Operation Mode 
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Figure 13: Operation Mode 

Activate DC Sync 
In order to set up Sync0 and Sync1 the check box Activate DC Sync has to 
be set. Data can only be entered into this screen if the check box Activate 
DC Sync is checked. Otherwise all subsequent input fields, selection lists 
and check boxes are grayed out and deactivated. 

Sync Unit Cycle 
The value displayed here is taken from the EtherCAT Master settings (Free 
run cycle time i.e. the cycle time of the EtherCAT-Master running free) as it 
is adjustable not at the EtherCAT Generic Slave but at the EtherCAT 
Master. Therefore the filed is grayed out and disabled here 

3.5.1 Sync 0 

Checkbox “Activate Sync 0” 
Sync 0 can be activated and deactivated by checking and unchecking the 
check box “Activate Sync 0”. 

3.5.1.1 Sync 0 Cycle Time 
 

 
Note:  Whether this value can be adjusted or not depends on the Device 
Description File of the appropriate device. 

 

 
Figure 14: Sync 0 Cycle Time 

The Sync 0 Cycle Time can either be derived from the Sync Unit Cycle 
Time adjusted at the EtherCAT Master (see above) by multiplying it with a 
factor or it can be entered directly.  

For calculating the Sync 0 Cycle Time from the Sync Unit Cycle Time, 
check the check box „Sync Unit Cycle“. The Sync Unit Cycle Time is 
multiplied with (or divided by) an adjustable factor.  

The following factors are available within the selector list: 
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For  specifying the Sync 0 Cycle Time directly, check the check box „User 
defined“. The value is specified in units of microseconds. The default value 
is 1000 microseconds. The allowed of values range from 0 to 
4,294,967.295 microseconds. If the specified value violates one of these 
limits, an error message is issued. 

3.5.1.2 Sync 0 Shift Time 

 
Figure 15: Sync 0 Shift Time 

The Sync 0 Shift Time is calculated in the following way: 

The Sync 0 Cycle Time is multiplied with (or divided by) an adjustable 
factor , the Sync 0 Shift Time Modifier.  

The following values are available within the selector list: 
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Note: In contrast to the Sync 0 Cycle Time described above, here also the 
factor 0 may be chosen! 

 

The default value for this factor is 

• 0: if the chosen operation mode (see above) is DC for synchronization 

• 1: otherwise. 

Then the value specified in the input field User defined is added to the 
product. The allowed range of values extends from -2147483.648 to 
+2147483.647. If a value outside of these limits is specified, an error 
message will be issued. 

The sum is displayed in the lower field having been grayed out.It is now 
used as the Sync 0 Shift Time. 
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3.5.2 Sync 1 

3.5.2.1 Checkbox “Activate Sync 1” 

Sync 1 can be activated and deactivated by checking and unchecking the 
check box “Activate Sync 1”. 

 

3.5.2.2 Sync 1 Cycle Time 

 
Figure 16: Sync 1 Cycle Time 

The Sync 1 Cycle Time is calculated as the product of the Sync 0 Cycle 
Time (see subsection “Sync 0” above) with a positive integer factor that is 
specified in the input field right of Sync 0 cycle time x.  

The range of allowed factors extends from 1 to 1024. If a value violating 
these limits is entered, an error message will be issued. 

The product is then displayed in the grayed out field just below of the input 
field. 

3.5.2.3 Sync 1 Shift Time 

 
Figure 17: Sync 1 Shift Time 
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3.6 Process Data 
In EtherCAT, the process data objects (PDO) are assigned to sync 
managers. A sync manager is used for synchronization of data 
communication on a certain communication channel. This channel is 
configured either for input or for output and either for cyclic or for acyclic 
communication. (This is defined within the device description file.) Up to 16 
sync manager can be configured. These are numbered from 0 up to 15. 
The process data dialog only displays the sync manager which is for cyclic 
communication. Possible sync managers for acyclic communication is 
displayed in the CoE MailBox dialog. 
The illustration below shows the process data dialog of the EtherCAT 
Generic Slave DTM: 

 
Figure 18: Configuration > Process data 

The process data dialog consists of three parts: 

• Sync Manager area 

• PDO Assignment area 

• PDO Content area 
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3.6.1 Sync Manager 
Within the process data dialog only those PDOs can be shown 
simultaneously, which are assigned to the same sync manager. 

The left part of the process data dialog represents the Sync Manager area 
which is used for choosing the sync manager to be used. It provides the 
Sync Manager table for choosing the sync manager whose PDOs are to 
be displayed, and additionally two checkboxes for PDO assignment and 
PDO configuration which however are relevant in case of variable 
configuration only. 

 
Figure 19: Configuration > Process data > Sync Manager 

The table Sync Manager displays the configuration of the sync managers 
for the device, as defined in its device description file (DDF). For each of 
the 4 sync managers available at maximum in the table, the following 
information is displayed: 
 

Parameter Meaning 
SM Sync Manager channel number (0-15) 
Byte length Sync Manager length in bytes 
Type Sync Manager type (Inputs/ Outputs) 
Flags Sync Manager flags (Flag F = fixed contents) 

Table 15: Parameters Process data > Sync Manager 

 

In case this device supports acyclic communication based on mailboxes the 
Sync Manager 0 is used for the mailbox output (master to slave) and the 
Sync Manager 1 is used for the mailbox input (slave to master).  
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If the device does not support acyclic communication based on mailboxes, 
Sync Manager 0 - 15 can be used for the Process data outputs and inputs 
(also see Figure Configuration > Process data > Sync Manager). 

The size of the Sync Managers is defined by the assigned PDO objects. In 
this case the PDO object is assigned to the Sync Manager 3 and because 
the content of this object has the size 8 the Sync Manager is configured to 
8 bytes. 

 

The read-only checkboxes below show the download flags which are 
defined in device description file. They have the following meaning: 
 

Checkbox Meaning 
PDO Assignment This flag indicates whether to download PDO assignment of Sync Manager. 

If this flag is checked, this means that PDO assignment of the slave is writable and special 
CoE Init-Commands should be generated by the EtherCAT Master DTM in the 
Configuration Information File. 
These CoE Init-commands include the indices of transmit/receive PDOs. Therefore the 
slave knows how such PDOs are related to the Sync Manager. 

PDO Configuration This flag indicates whether to download PDO mapping. 
If this flag is set as checked, this means that PDO mapping of the slave is writable and 
special CoE Init-Commands should be generated by the EtherCAT Master DTM in the 
Configuration Information File. 
These CoE Init-Commands include the indices of mapped process data objects. Therefore 
slave knows how mapped PDOs are related to transmit /receive PDOs. 

Table 16: Meaning of Checkboxes 
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3.6.2 PDO Assignment (Index 0x1C10- 0x1C1F) 
The upper right part of the process data dialog represents the PDO 
Assignment area for the sync manager chosen within the left part of the 
window. It contains the transmit/receive PDOs. 

Thus the contents of this table depends on the choice of the sync manager 
in the left part of the window. If a sync manager with type “Outputs” is 
selected, all defined receive PDOs (Index 0x1600 -0x17FF) in the device 
description file will be shown in this table.  

Similarly, if a sync manager with type “Inputs” is selected, all defined 
transmit PDOs (Index 0x1A00 -0x1BFF) will be shown in this table. 
 

 
Figure 20: Configuration > Process data > PDO Assignment 

 

For the transmit/receive PDOs assigned to the chosen sync manager, the 
following values are displayed: 
 

Parameter Meaning 
Name Name of the PDO 
Activate Activation check box for assigned PDO of the selected 

Sync Manager 
Index Object index of the PDO  
Byte length Length of the PDO in bytes 
Flags Flags assigned to the PDO 
Description  Description of the PDO 

Table 17: Parameters Process data > PDO Assignment 
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The PDO assignment is stored in a sync manager channel object within the 
object dictionary of the EtherCAT slave. The index of such an object is 
displayed in the headline of the PDO assignment area, and it has a 
relationship with the sync manager channel number(n) :  
Index = 0x1C10 + n  ( n = 0…15) 

In the current example the information was taken from the object with the 
index 0x1C12 indicating sync manager 2 had been chosen for display. 

For slave devices with selectable PDO assignment, PDO/PDOs can be 
selected from the given list of multiple fixed PDOs according to the rules 
defined by the device description file. 
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3.6.3 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF) 
The lower right part of the process data dialog represents the PDO Content 
area. It contains the mapped process data objects of the transmit/receive 
PDO, which has been selected in the upper right part of the window. 

 
Figure 21: Configuration > Process Data > PDO Content  

For the mapped process data objects, the following values are displayed: 
 

Parameter Meaning 
Index Object index Subindex of the PDO 
Sub index Sub index for the PDO 
Byte length Size of the PDO entry in Byte 
Offset Offset of the PDO entry (relative to 0x1600 for output 

and to 0x1A00 for input PDOs) 
Name Name of the PDO entry 
Type Data type of the PDO entry 

Table 18: Parameters Process Data > PDO Content 

 

The PDO content is stored in a transmit/receive object within the object 
dictionary of the EtherCAT slave. You can find the correct index of the 
selected transmit/receive PDO in the headline of the PDO assignment area. 

In the current example the information was taken from the object with index 
0x1604.  

For an explanation of the navigation buttons see section “Table Line” of this 
document. 
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3.7 Mailbox 

3.7.1 CoE 
For slave devices supporting the CoE MailBox, the following dialog page is 
additionally displayed: 

 
Figure 22: Configuration > Mailbox > CoE Mailbox Settings 

The dialog page provides the following information: 

• The channel number of the sync manager (for mailbox input and output) 

• The configured mailbox size (this applies both for the input mailbox and 
for the output)mailbox  

The complete MailBox configuration for each slave with MailBox support is 
done in the EtherCAT Master-DTM. 
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4 Description 
4.1 Overview Description 

The Description pages contain the following information: 

• XML Viewer page: the devices XML file content in HTML style. 

Description Dialog Pages 
The table below informs about the contents of the Description dialog page: 
 

Subsection Manual  
Page 

XML DDF Viewer 37 

Table 19: Descriptions of the Description Pages 

 

 
Figure 23: Navigation Area – Description 
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4.2 XML DDF Viewer 
The XML DDF Viewer displays the content of the DDF file of the device 
which is stored in an XML format.. 

Under Filename the absolute file directory path and the file name of the 
displayed DDF file is displayed. Find what offers a search feature to search 
for text contents within the text of the DDF file. 

In the DDF Viewer window on the left side, the line number is displayed for 
simple overview, the further entries show the DDF file in text format. 
 

Parameter Meaning 
FIlename File directory path and the file name of the displayed DDF file. 
Find what Search feature to search for text contents within the text of the 

DDF file. 
Match case Search option 
Match whole word Search option 

Table 20: Device Description – XML DDF Viewerr 

 

The XML DDF Viewer page consists of the following elements: 

• File name shows the absolute path of the DDF file. 

• Find what offers searching for specific text within the DDF file. 

• Using the Find Next button allows you to jump to the next occurrence of 
the text to be searched for within the XML DDF file. 

• Check Match case if you want to perform a case-sensitive search. 

• Check Match whole word if only entire words should match and 
fragments of words should be excluded from matching. 

 

 
Note: You can also access the search functionality of the XML DDF 
Viewer by typing Ctrl-F on the keyboard. 
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5 Appendix 
5.1 User Rights 

User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Configuration panes of the generic EtherCAT Slave DTM 
you do not need special user rights. Also all users can select the decimal or 
hexadecimal Display mode or sort table entries. 
 

 
Note: To edit, set or configure the parameters of the Configuration 
panes, you need user rights for Maintenance, for Planning Engineer or for 
Administrator. 

 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

5.1.1 Configuration 
 Observer Operator Maintenance Planning 

Engineer 
Adminis-
trator 

     General D D X X X 
     Behavior D D X X X 
     Distributed Clock D D X X X 
     Process Data D D X X X 
     Mailbox D D X X X 

Table 21:  Configuration (D = Displaying, X = Editing, Configuring) 

 

 

5.2 References 
[1] Device Type Manager (DTM) Style Guide, Version 1.0 ; FDT-JIG - Order No. 

<0001-0008-000> 
[2] EtherCAT Communication Specification, August 2007 
[3] EtherCAT Slave Protocol API Manual, Revision 3 (V4), Hilscher GmbH 2013 
 EtherCAT Slave Protocol API Manual, Revision 21 (V2), Hilscher GmbH 2013 
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5.5 Glossary 
CoE 

CANopen over EtherCAT 

CoE denominates a method for accessing an object dictionary which has 
been adopted for use in EtherCAT from CANopen. 

DDF 

Device Description File. 

DTM 

Device Type Manager. 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration or for diagnosis of devices. 

E²PROM 

Electronically erasable Programmable Read-Only Memory 

E-Bus 

Bus system based on LVDS standard 

EDS 

Electronic Data Sheet 

EtherCAT-Master 

A device which is responsible for the configuration, parameterization of the 
EtherCAT segment, all connected devices’ controllers, and cyclic process 
data exchange, mailbox and diagnostics services. 

EtherCAT-Port 

Physical type of data transmission used by EtherCAT. An EtherCAT Slave 
Master can have up to 4 EtherCAT ports. Can be one of the following three 
alternatives: 

• E-Bus 

• 100Base-TX 

• 100Base-FX 

EtherCAT-Slave 

A device which is configured by the Master, receives telegrams with output 
data, commands from it and provides input and status data. 

FDT 

Field Device Tool 

FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers 
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FMMU 

Fieldbus Memory Management Unit  

A field bus memory management unit organizes a mapping of EtherCAT 
logical addresses to physical addresses. 

LVDS 

Low Voltage Differential Signals 

A data transmission standard specified in ANSI/TIA/EIA-644-1995 and 
used in Beckhoff’s E-Bus. 

 

Object Dictionary 

An object dictionary is a storage area for device parameter data structures. 
It is accessed in standardized manner very similarly as this is done in 
CANopen.. 

PDO 

Process Data Objekt 

Specific data object for cyclic data communication. 

SDO 

Service Data Objekt 

Specific data object for acyclic data communication, i.e. mailbox-based 
communication. It is typically used for accessing the object dictionary. 

Sync Manager 

Synchronization Manager 

A sync manager synchronizes the data communication on a specific 
communication channel. It is configured for managing either input or output 
and for working either cyclically or acyclically based on mailboxes. 
Configuration is done within the DDF file. Up to 4 sync managers numbered 
0 to 3 can be configured. 

XML 

Extensible Markup Language 

A versatile data storage format defined by the World Wide Web Consortium 
(W3C). It is based on elements and attributes. In EtherCAT, it is used in 
device descriptions stored in DDF files 
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E-Mail: info@hilscher.jp 
Support 
Phone: +81 (0) 3-5362-0521 
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Hilscher North America, Inc.  
Lisle, IL 60532 
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